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EXECUTIVE SUMMARY 

This deliverable describes in detail all the procedures and actions to be done in order to 

install, configure and program the SportE
2
 When Module as a product, already assessed and 

validated for sport facilities energy retrofit market. The module development and testing is 

complete and it is ready for market deployment after its deployment and validation at the 

three project’s pilots. 

After a brief introduction, the “Module Installation” Chapter illustrates, step by step, the 

commissioning and the installation procedure instructions (both hardware and software) to be 

performed by any subcontractor that has adequate technical skills. It is described the 

procedures needed to implement the physical installation of the Automation Server (core of 

the SportE
2
 When module) for the installers and it is reported an installation check list 

designed to verify the correct setting up. A list of the possible hardware troubleshooting and 

relative solutions is also presented in order to help the installer during the installation phase. 

After installation practices, we described the module configuration and programming. In 

particular, we reported how to configure and how to program the module: the instructions to 

add an Automation Server to the system, to set multiple I/O points, the analog values, the 

weekly events etc. Afterwards, it is explained how to create and import functional blocks and 

script programs in order to program it. The sequences reported have been experienced and 

tested at the three project pilots. At the end of this chapter some typical optimized control 

rules for sport facilities (see deliverable D4.3 and D4.4), defined and assessed along the 

project in the three pilots, are reported.  

The next Chapter illustrates the module acceptance testing: the SportE
2
 When module shall be 

tested against the appropriate sequence of operation. This section is a sort of workbook that 

describes a defined set of tests to check the correct module delivery and functioning. System 

start-up procedure and testing steps are described in order to assure a successful deployment 

of the module at sport facilities. 

Chapter 8 presents the graphic user interface (GUI) library, developed in the final project 

period, implemented to help the installers about the creation and configuration of the graphics 

user interfaces (both machine to machine and human to machine user interfaces) related to 

sport facilities.  

Chapter 9 is dedicated to the users of the SportE
2
 When Module: energy or facility mangers, 

owners, maintenance personnel etc. Within this chapter we have summarized the training 

programs, a general workstation overview, alarms, trend logs management, how to generate 

reports and manage facilities systems and plants. 

http://www.sporte2.eu/
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1. INTRODUCTION 

This deliverable provides a detailed description of the SportE
2
 When module complete, ready 

for market deployment after installation and validation at the three project’s pilots. Installation 

procedure and sequence have been defined and detailed in the following (see Chapter 5: 

Module Installation) for installers, either facility management company or electricians. 

Chapter 6 presents in details the Module Configuration and Programming. In Chapter 7 

(Module Acceptance Testing), all the validation tests (at communication, device, system 

level) are described as well as the system start-up and successive performance verification test 

for SportE
2
 When module delivery to the customer. Specific expertise and license are needed 

for these phases; therefore, only Schneider Electric accredited/authorized partners can 

configure and program the module. 

The module is a smart integration of hardware components, communication protocols, data 

models, machine-to-machine, and machine to human interfaces. In this deliverable, rather 

than describing in details the module as a product (hardware and software components), 

already detailed in deliverable D3.3, we focus on the procedures and actions to be done in 

order to install, configure and deliver the SportE
2
 When module. Moreover, a graphic user 

interface (GUI) library has been developed specifically for sport facilities to help the installers 

about the creation and configuration of the graphics user interfaces. The last part of this 

document is dedicated to the end users of the SportE
2
 When module: energy and facility 

mangers, owners, maintenance personnel etc, where the training and the main use functions of 

the module are presented. 

We briefly remind here (for sake of clarity) that SportE
2
 When module consists essentially of 

a Control Unit and its I/O modules, a Control Set-Points Database and an Interface Unit as 

detailed in previous deliverables. 

Figure 1: SportE2 When module layout. 

 Control Unit – It consists of the Automation Server, it is responsible to manage the 

set points and variable status of the field controllers used in the facility network. The 

control can be automatic or supervised by human operator by means of the interface 

unit installed in the Enterprise server. 

 Control Set points Database – This module is a relational database allowing to store 

set points values of the control devices.  

http://www.sporte2.eu/
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 Control Interface Unit – This unit will allow visualizing the status of the set points 

of each deployed system and remote controller.  

The SportE
2
 When module is provided of a graphical, web-based, operator interface that 

allows for instant access to any system through a standard browser to get a fully 

integrated, customized solution that ensures different players to have the most efficient and 

effectively managed building configuration for their needs or requirements.  
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2. MODULE INSTALLATION 

SportE
2 
When Module installation procedure was proposed in D3.3 according to: 

 the technical specifications and requirements of the hardware and software 

components of the module 

 time and cost effectiveness 

 the integration requirements with the other SportE
2 

modules (How and Why module in 

particular) as found in WP5 

 the installation general plan at Pilot level as defined and tested in WP6 

The experience achieved at the three project pilots (quite different one from the other under 

several aspects, both technical and logistic) has allowed us to define a protocol (e.g. a 

standardized procedure) to a correct and time-effective installation of the SportE
2 

When 

module, which is described in the following. This commissioning procedure has been 

designed and foreseen for installers, either facility management company or electricians (also 

said “the contractor” in the followings).  

5.1 Commissioning procedure 

In order to facilitate the installation of SportE
2 

When Module, a sort of installation packages 

have been defined. These installation packages cover all the step of the installation procedure 

and can be applied singularly according to the module components needed. In particular, this 

allows to deliver partial installation or to upgrade the system at needed time. With the 

installation packages you install, repair, upgrade, or reinstall all the components. When 

upgrading or reinstalling, you can keep or remove software settings, licenses, or the database 

or part of them according to the customers’ needs. 

The When Module consists of the following installation packages: 

- Hardware components: field devices and AS (with I/O) 

- WorkStation: Graphics Editor, Script Editor, Function Block Editor, WorkPlace Tech 

Editor 

- Device Administrator 

- Enterprise Server 

The installation files for Graphic Editor, Script Editor, Function Block Editor, and WorkPlace 

Tech Editor are bundled into the WorkStation installation package. 

The Contractor (e.g. customer) shall provide all labor necessary to install, initialize, start-up 

and debug all system software, this includes any operating system software or other third 

party software necessary for successful operation of the system.  

Hereafter, we reported the whole commissioning process, discriminating the offline and 

online operations to be done. 

Commissioning Process: “Offline” 

Enterprise Server and Automation Servers Online, all other configuration is Offline. 

 
1. Define Customer Requirements 

2. Design Architecture and Hardware 

3. Determine Data-flow 

4. Install/Upgrade When Module Software 

http://www.sporte2.eu/
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 Device Administrator 

 Enterprise Server 

 Workstation 

5. Microsoft Windows - Prepare Project 

Database 

 Default Database Copied and 

Renamed 

6. Device Administrator - Prepare All 

Automation Servers 

 Upgrade Software and Define IP 

Addresses 

7. Enterprise Server and Workstation – Create 

and Configure ES,AS, and I/O Modules – 

ONLINE 

  Rename ES 

  Add AS 

  Add Programs (FB or Script) 

  Create Internal Variables (AS) 

  Create I/O Points 

  Bindings 

8. Create Programs 

 Function Block 

 Script 

9. Enterprise Server and Workstation – Create 

and Configure Fieldbus – OFFLINE 

 Assign Programs 

 Create I/O Points 

 Bindings 

10. Enterprise Server and Workstation – Create 

and Configure Operator Interface Part I 

 Alarms 

 Time Schedules 

 Graphics/Panels 

 Trends logs and charts 

 Workspaces 

 Backups 

 

Commissioning Process: Online 

Engineering PC to Customer PC, all online. 

 
1. Automation Servers, I/O Modules, and 

Fieldbus Devices Physically Installed 

  Commission Fieldbus Devices 

2. Configure Customer PC IP Address and 

Install When Module Software 

 Device Administrator 

 Enterprise Server 

 Workstation 

 Reports (on Reports Server PC) 

3. Licensing Website - Activate Customer 

Licenses 

 Internet connection required on 

Customer 

License Server PC 

4. Windows Explorer - Move Project db from 

Engineering PC to Customer PC 

5. Enterprise Server and Workstation – Create 

and Configure Operator Interface 

 Users and Groups 

 Authority 

 Workspaces 

 Backups 

 Etc. 

7. WebReports, Reports Server, Enterprise 

Server, and Workstation – Create and 

Configure Reports 

8. System Check 

 Communication, data-flow, bandwidth 

utilization 

 Graphics 

 Trends 

 Users 

 Alarms 

9. Backup db 

http://www.sporte2.eu/
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Figure 2 summarizes the When Module commissioning process described above and in D3.3. 

 

Figure 2: WHEN Module commissioning standardized process. 

5.2 Module Installation Procedure 

Installation of the When module can be performed by any subcontractor that has adequate 

technical skills and authorization. The installation phase of the module consists of the 

following sequence, detailed in the next paragraphs. This installation sequence has been 

defined and tested in order to assure good practice and standardized installation. 

  

Figure 3: Module installation procedure and its phases. 

 

Wiring, 
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Cable 
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Wiring, Conduit, and Cable 

All wiring have to be installed in accordance with all applicable electrical codes and will 

comply with equipment manufacturer's recommendations. At the completion of the work, all 

equipment has to be checked and thoroughly cleaned.  

All wire will be copper and meet the minimum wire size and insulation class. Power and 

Class One wiring may be run in the same conduit, as well as Class Two and Three. Where 

different wiring classes terminate within the same enclosure, maintain clearances and install 

barriers per the National Electric Code, instead where wiring is required to be installed in 

conduit EMT shall be used: conduit shall be minimum 1/2 inch galvanized EMT. Set screw 

fittings are acceptable for dry interior locations, watertight compression fittings shall be used 

for exterior locations and interior locations subject to moisture.  

Flexible metallic conduit (max. 3 feet) shall be used for connections to motors, actuators, 

controllers, and sensors mounted on vibration producing equipment, liquid-tight flexible 

conduit shall be use in exterior locations and interior locations subject to moisture. Junction 

boxes shall be provided at all cable splices, equipment termination, and transitions from EMT 

to flexible conduit, interior dry location J-boxes shall be galvanized pressed steel, nominal 

four-inch square with blank cover. Exterior and damp location JH-boxes shall be cast alloy FS 

boxes with threaded hubs and gasketed covers. Where the space above the ceiling is a supply 

or return air plenum, the wiring shall be plenum rated; teflon wiring can be run without 

conduit above suspended ceilings. It is worth to note that any wire run in suspended ceilings 

that is used to control outside air dampers or to connect the system to the fire management 

system shall be in conduit.  

Fiber optic cable shall include the following sizes: 50/125, 62.5/125 or 100/140. Only glass 

fibre is acceptable, no plastic, and this cable shall only be installed and terminated by an 

experienced contractor. 

Hardware Installation 

All controllers are to be mounted vertically and per the manufacturer’s installation 

documentation. The 120VAC power wiring to each Ethernet or Remote Site controller shall 

be a dedicated run, with a separate breaker. Each run will include a separate hot, neutral and 

ground wire, the ground wire will terminate at the breaker panel ground: this circuit will not 

feed any other circuit or device. 

A true earth ground must be available in the building, it not should use a corroded or 

galvanized pipe, or structural steel.   

Wires are to be attached to the building proper at regular intervals such that wiring does not 

droop: wires are not to be affixed to or supported by pipes, conduit, etc. Conduit in finished 

areas will be concealed in ceiling cavity spaces, plenums, furred spaces and wall construction. 

Only metallic surface raceway may be used in finished areas on masonry walls. All surface 

raceway in finished areas must be color matched to the existing finish within the limitations 

of standard manufactured colors. 

Conduit, in non-finished areas where possible, will be concealed in ceiling cavity spaces, 

plenums, furred spaces, and wall construction. Exposed conduit will run parallel to or at right 

angles to the building structure. 

Wires are to be kept a minimum of 3 inches from hot water, steam, or condensate piping. 

Where sensor wires leave the conduit system, they are to be protected by a plastic insert; wire 

will not be allowed to run across telephone equipment areas. 

Installation Practices for Field Devices 

Well-mounted sensors will include thermal conducting compound within the well to insure 

good heat transfer to the sensor. Actuators will be firmly mounted to give positive movement 

http://www.sporte2.eu/
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and linkage will be adjusted to give smooth continuous movement throughout 100 percent of 

the stroke. Relay outputs will include transient suppression across all coils, suppression 

devices shall limit transients to 150% of the rated coil voltage. 

Water line mounted sensors shall be removable without shutting down the system in which 

they are installed. For duct static pressure sensors, the high pressure port shall be connected to 

a metal static pressure probe inserted into the duct pointing upstream, the low pressure port 

shall be left open to the plenum area at the point that the high pressure port is tapped into the 

ductwork. For building static pressure sensors, the high pressure port shall be inserted into the 

space via a metal tube, pipe the low pressure port to the outside of the building. 

Enclosures and Field Interface Panel 

For all I/O requiring field interface devices will be mounted in a field interface panel (FIP). 

The Contractor shall provide an enclosure which protects the device(s) from dust, moisture, 

conceals integral wiring and moving parts; FIPs shall contain power supplies for sensors, 

interface relays and contactors, and safety circuits. The FIP enclosure shall be of steel 

construction with baked enamel finish; NEMA 1 rated with a hinged door and keyed lock. 

The enclosure will be sized for twenty percent spare mounting space, all locks will be keyed 

identically. All wiring to and from the FIP will be to screw type terminals, analog or 

communications wiring may use the FIP as a raceway without terminating. The use of wire 

nuts within the FIP is prohibited, all outside mounted enclosures shall meet the NEMA-4 

rating. The wiring within all enclosures shall be run in plastic track, those within controllers 

shall be wrapped and secured. 

It is important identify all control wires with labeling tape or sleeves using words, letters, or 

numbers that can be exactly cross-referenced with as-built drawings. All field enclosures, 

other than controllers, shall be identified with a Bakelite nameplate, the lettering shall be in 

white against a black or blue background. Junction box covers will be marked to indicate that 

they are a part of the When module.  

All I/O field devices (except space sensors) that are not mounted within FIP's shall be 

identified with name plates, those inside FIP's shall be labeled. 

Demolition of the existing control system will occur after the new control system is in place 

including new sensors and new field interface devices, switch-over from the existing control 

system to the new system will be fully coordinated with the Owner. A representative of the 

Owner will be on site during switch-over. Sufficient installation mechanics will be on site so 

that the entire switch-over can be accomplished in a reasonable time frame. 

The location of sensors is per mechanical and architectural drawings according to How 

Module specifications. For example: space humidity or temperature sensors will be mounted 

away from machinery generating heat, direct light and diffuser air streams. Outdoor air 

sensors will be mounted on the north building face directly in the outside air. Field enclosures 

shall be located immediately adjacent to the controller panel(s) to which it is being interfaced. 

Each I/O device (both field mounted as well as those located in FIPs) shall be inspected and 

verified for proper installation and functionality. A checkout sheet itemizing each device shall 

be filled out, dated and approved by the Project Manager for submission to the owner or 

owner’s representative. 

Software Installation 

The software is installed on the Enterprise Server PC and performs key functionality, control 

logic, trend logging and alarm supervision. The Enterprise Server (the other core part of the 

Control Unit), at the top of the When module architecture has a Windows® application 

version server, it collects site-wide data for aggregation and archiving; it is flexible enough to 

run stand-alone applications. Central point from which users can configure, control, and 

monitor the entire system, hosts the historical and configuration databases.  

http://www.sporte2.eu/
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The Enterprise Server (ES) is equipped with native BACnet, Lonworks and Modbus support. 

The workstation allow to communicate with the ES by means of customer/engineer interface: 

this can be installed on any Windows machine and connected to any available servers. It is 

envisaged a security login and system access in order to guarantee a feasible level of safety. 

The workstation offers several different options that allow the user to easily interact and 

control the whole system as deeply described in deliverable D3.2: 

 Customizable workspaces  

 Watch window views 

 Powerful alarm management 

 Simple alarms, events and schedule configuration 

 Workspace Wizard  

Another way to interact with the Enterprise Server and the Automation Server is by means of 

the Webstation: this can direct access them via web browser such as Internet Explorer 8 (32 

bit) or Firefox 6.2 (32 bit). Also in the case is required user name and password for log on and 

it is possible to view graphics, trends, schedules, reports, change values (e.g. temperature set 

points), manage alarms and view customized workspaces as configured for WorkStation. 

There is a particular software, called Device Administrator, used to upgrade and configure the 

Automation Server IP address; this is typically installed on Enterprise Server PC but it can be 

installed on any PC used to service the system. Through a software administrator it is 

moreover possible to manage the start and stop of the Enterprise Server and modify the 

communication ports. 

The WebReports software is used to generate reports and graphical or tabular reporting; once 

that these are generated, it can possible export and save data to standard formats as xls, doc, 

pdf and customize the results.  

To use the software previously described, and some editor analyzed in the next paragraph, it is 

necessary to have a license. Licensing is characterized by some features: 

 It will be possible the troubleshooting via web 

 Availability to setup alerts regarding license usage and availability  

 Re-hosting available via the Internet  

 Licenses can only be activated with the License Server connected to the Internet  

The license server, installed at the same PC as the Enterprise Server, is configured as a part of 

the License Administrator, and allows to manages software licenses. 

 

The License administrator is a tool software used for: 

 Provide registration details 

 Add licenses 

 View current licenses status 

 Assign the license server address 

 Run diagnostics 

The Contractor shall provide all labor necessary to install, initialize, start-up and debug all 

system software, this includes any operating system software or other third party software 

necessary for successful operation of the system. The Contractor will provide all labor to 

configure those portions of the database that are required by the points list and sequence of 

operation. 

Unless otherwise directed by the owner, the Contractor will provide color graphic displays as 

depicted in the mechanical drawings for each system and floor plan. For each system or floor 

http://www.sporte2.eu/


SportE
2
 D3.4  Page 13 of 65 

SPORTE
2
 – D3.4 When Module Complete 

www.sporte2.eu   

plan, the display shall contain the associated points identified in the point list and allow for 

setpoint changes as required by the owner.   

The Contractor will configure a minimum of 4 reports for the owner. These reports shall, at a 

minimum, be able to provide: 

 Trend comparison data 

 Alarm status and prevalence information 

 Energy Consumption data 

 System user data 

 

As software documentation will include the following: 

 Descriptive point lists 

 Application program listing 

 Application programs with comments. 

 Printouts of all reports. 

 Alarm list. 

 Printouts of all graphics  

 Commissioning and System Startup 

 

Controller and Workstation Checkout 

A field checkout of all controllers and front end equipment (computers, printers, modems, 

etc.) shall be conducted to verify proper operation of both hardware and software. A checkout 

sheet itemizing each device and a description of the associated tests shall be prepared and 

submitted to the owner or owner’s representative by the completion of the project. 

5.3 Automation Server physical installation 

The Automation Server has been deeply presented in deliverable D3.2. Hereafter, we 

summarize only the installation practices. 

The power supply that supports the Automation Server and its family of I/O modules is a 

modular system that delivers power and communications on a common bus. Connecting 

modules is a one-step process: just slide the modules together using the built-in connectors. A 

30 W power supply can deliver power to the automation Server and a number of I/O modules. 

The power supply input (from main power) and output (to modules) are galvanically isolated, 

this removes the risk of damage due to earth currents and permits the input power to be wired 

without concern for polarity matching. 

The When Module devices have a terminal base and an electronics module. Each module 

contains two handles which can be withdrawn to facilitate removal or insertion; in their inner 

position the handles lock the module to the terminal base, this effectively prevents 

unintentional separation. Two clear plastic label carriers provide a means to identify the unit, 

show field marking designations, and to protect factory labeling from dirt. Wiring connections 

are made at terminal blocks contained on the terminal base: these terminals are accessible 

from the front when the module is fitted. Power for most devices, other than the power supply 

modules, is taken from the 24 VDC rails of the backplane that is part of the terminal base; the 

backplane also serves as an address bus. 

Installation instructions 

To install an AS module on a terminal base it is needed to follow the instructions shown 

below:  

1) Pull out the two handles on the left and right sides of the device. 

http://www.sporte2.eu/
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2) Plug in the device to the terminal base, ensuring that the PCB header pins align 

correctly with the backplane socket and press firmly. You should make sure that the 

device type and the terminal base type 

match: a mismatch can cause electric 

shock and damage the module. The correct 

device type is shown on the backplane 

board label of the terminal base. 

3) Push the handles in firmly to lock the 

device in place. 

4) Open the clear plastic label carriers. 

5) Write and insert the labels. 

6) Close the label carriers. 

A backplane board is mounted in the terminal base 

plastic for the devices. It distributes in a bus system 

power, communication, and address information to all connected devices. 

 

Other sizes are available for terminal bases of other widths. 

Furthermore, there are two versions: 

• The AS and IO device version passes power through from the left connector to the right 

connector. 

• The power supply version does not pass 

power through from the left to the right 

connector. 

The backplane boards incorporate different 

locations of the 6x2 electronics module 

connector to prevent mismatched modules 

from damaging the electronic circuits. 

 

The backplane board includes circuitry that provides a mated Automation Server, IO or other 

device, or power supply/UPS with a 5 bit address. This allows up to 32 modules in a fully 

loaded system. 

The logic circuitry accepts a 5 bit address 

input from a module to the left and adds “1” 

to the input address. The incremented output 

address is passed to the next backplane in the 

device to the right. The leftmost slot has the 

address 1. 

The address circuitry on the backplane 

receives it power from the +24 V backplane 

power. This is separated from the +24 V bus 

power. 

 

The AS device is designed mainly for 

installing on DIN rails in a cabinet. To ensure that the correct electronics module is used with 

the correct terminal base, you must always check that the warning label shows which device 

is to be connected: write the intended module type, if it is not already printed, on the label. 

When several DIN rails are needed, an S-cable is used to connect the devices of two 

succeeding rails. 
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The Automation Server and its Power Supplies and I/O modules are called an I/O bus. It is 

worth to use the follow positions for the devices on the I/O bus: 

• Position 1, Power Supply 

• Position 2, Automation Server 

• Position 3-32, I/O Modules and extra Power Supplies as needed based on power budget  

 

All connected devices automatically get an address, from 1 to 32, by means of the I/O bus in 

the terminal base. Also, the Power Supply device gets an address, but the PS-24V model does 

not use it. When you replace a device, the new device automatically picks up the same, 

correct address. A maximum of 32 devices can be connected to the same I/O bus. When 

several DIN-rails are used, an S-cable connects the last device on one DIN rail with the first 

device on the next. To cover wider cabinets, you can serially connect up to two I/O Module S-

cables.  

There is a great advantage in having a separate terminal base because each of those can be 

installed and wired long before the electronics module with the application program and data 

is supplied. 

Replacing an electronics module is done in seconds since no terminal wiring is affected, 

however different electronics modules may require different types of terminal bases. It is vital 

to put the electronics module in the correct type of terminal base; failure to do so may lead to 

malfunctioning devices and/or exposure to dangerous voltage. 

 

There are two USB host ports facing down to 

connect to external devices, such as telephone 

modems, printers, memory expansions (USB 

“sticks” or hard disc drives), and expansion 

modules. The USB device port on the front is 

intended for basic PuTTY console functions and 

program download from a PC by means of 

Device Administrator. It is connected to a PC or 

a downstream port of a hub by means of Standard 

USB cables, maximum length 3 m (10 ft). The 

Ethernet communication is performed over a 

10/100BaseTX, 10 or 100 Mbps, twisted pair 

network. The network is connected to the 

Automation Server by an RJ45 connector: 

for an Ethernet connection, use Cat 5 twisted pair cable with a maximum length of 100 m 

(330 ft). 

 

You perform the following steps to power-up a device: 

 

1. Check that the device is properly seated in its terminal base. 

2. Check that all wiring is correct. 

3. Ensure that power is supplied to the backplane. 

4. After powering up, check that the Status LED is in the constant green state (can also be off 

briefly during each period of activity). 

5.4 Check list for installer: troubleshooting 

During the SportE
2 

When Module installation could occur some hardware problems that are 

listed below, together with the related possible solutions, in order to help the installer during 

the verification phase. This list of problems have been realized thanks to the experience 

acquired during the three pilots deployment. 

http://www.sporte2.eu/


SportE
2
 D3.4  Page 16 of 65 

SPORTE
2
 – D3.4 When Module Complete 

www.sporte2.eu   

 

General Hardware Configuration Problem 

The Automation Server or its I/O modules respond erratically or not at all. 

 

The solutions are listed in order: the solution most likely to fix the problem is listed first. 

Work through each solution until the problem is resolved. 

• Ensure that all the devices are connected in the correct order: 

- Position 1: Power supply 

- Position 2: Automation Server 

- Positions 3 to 32: I/O modules and additional power supplies 

• Ensure that there is only one Automation Server on the I/O bus, and that it is in position 2. 

• Ensure that the total power consumption for each power supply is not exceeded. 

 

No Communication with Automation Server 

The Automation Server does not respond to any type of communication. 

 

The solutions are listed in order: the solution most likely to fix the problem is listed first. 

Work through each solution until the problem is resolved. 

• Ensure that the Automation Server has completed any firmware updates, because no 

communication is possible before the update finishes. 

• Ensure that the Automation Server has a correct IP address and host name. 

• Find out if the Automation Server IP address has been modified. If the IP address has been 

assigned with the DHCP function, this address may have been changed by the DHCP server. 

To avoid this problem, use the host name instead of the dynamic IP address to connect to the 

Automation Server. 

• Ensure that the Automation Server has been correctly installed onto a terminal base TB-AS-

W1, in position 2 on the I/O bus. Other terminal base types will not work. 

• Ensure that no pins in the electronics module have been bent when connected to the 

Terminal Base. 

Particularly, check the pins connecting to the backplane of the Terminal Base. Check the two 

different positions (left and right) of the female 6x2 connector on the backplane to distinguish 

the Terminal Base for the power supply from the other devices. 

• Restore the Automation Server firmware, if you suspect that it has been damaged. 

 

No Communication with I/O Module 

One or more I/O modules do not respond to any type of communication. 

The solutions are listed in order: the solution most likely to fix the problem is listed first. 

Work through each solution until the problem is resolved. 

• Ensure that the I/O module has been correctly installed onto a Terminal Base of the correct 

type, in position 3 or higher on the I/O bus. Other Terminal Base types will not work. 

• Ensure that the I/O module has been assigned a Module number 3-32 that corresponds to its 

position 3-32 on the I/O bus. When a new module is created it is automatically assigned the 

Module no. 0 which is an invalid number, and so you must assign a valid number to the 

module.  

• Ensure that no pins in the I/O module have been bent when connected to the Terminal Base. 

Particularly, check the pins connecting to the backplane of the Terminal Base. Note also the 

two different positions (left and right) of the female 6x2 connector on the backplane to 

distinguish the Terminal Base for the power supply from the other devices. 
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Incorrect I/O Values 

One or more I/O values are incorrect. 

 

The solutions are listed in order: the solution most likely to fix the problem is listed first. 

Work through each solution until the problem is resolved. 

• Ensure that the HAND/AUTO/OFF override switches are set to the intended position for the 

outputs. 

• Ensure that the potentiometers for analog outputs that use the HAND switch position are set 

to the intended values. 

• Ensure that the input types are correctly set. This is important for the thermistor input types. 

 

I/O module incorrectly configured 

The I/O module status LED is not a solid green and the module status in the Properties pane 

is not Configured. The I/O module is offline, in Low power, or Bootloader modes, is Out of 

tolerance (24V out of tolerance), or contains an error. Also, the module ID is not set 

correctly, a module mismatch exists, or the I/O point does not exist on a channel other than 

Null. 

The solutions are listed in order: the solution most likely to fix the problem is listed first. 

Work through the solution until the problem is resolved. 

• Ensure that the I/O module is online by verifying that the Comm status property is set to 

Online. 

Check also that the I/O module is securely connected to the Automation Server and that the 

module ID is set to the position occupied by the I/O module. 

• Ensure that the type of physical I/O module matches the type of module assigned to it (that 

is, the module in the I/O Bus folder with the same module ID). 

When the I/O module type does not match the type created in the database, the Module type 

mismatch property is True. 

• Ensure that the Comm status of the unconfigured I/O module is set to Online and that the 

Module type mismatch is False. If so, confirm that at least one point in the module is assigned 

a channel other than 0. 

Right-click the I/O module, select the I/O wiring list, and verify that at least one point is 

assigned a channel. 

• Ensure that the Module status is not set to Low power. If the status is Low power, recover 

the I/O module. 

• Ensure that the Module status is not set to Bootloader. If the status is Bootloader, update the 

module firmware to the current version. 

• Ensure that the Module status is not set to 24v out of Tolerance. 

If the status is 24v out of Tolerance, the power supplied to the I/O module may have dropped 

below ~19 VDC. 

• Ensure that the Module status is not set to Unreliable. 

If the status is Unreliable, the I/O module has detected an error. 

 

Input point not functioning correctly 
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The parent I/O module is Configured and online. However, the input point is not functioning 

correctly. The module status is Unconfigured, the input point is offline, unreliable, forced, or 

configured incorrectly (for example, wrong point type, wrong channel, incorrect units, 

scaling, or threshold). Also, the input channel is miswired, or the I/O module is defective. 

When the input point is not functioning correctly, the problem is usually that the value is not 

in the expected range or does not update properly. 

The solutions are listed in order: the solution most likely to fix the problem is listed first. 

Work through each solution until the problem is resolved. 

• Ensure that the Comm status of the input point is set to Online and that the parent I/O 

module is Configured and Online. 

Check also that the I/O module is securely connected to the Automation Server and that the 

module ID is set to the position occupied by the I/O module. 

• Ensure that the point’s Reliability is set to Reliable. 

Check the wiring of the input point and verify that the Lower and Upper reliability level are 

set correctly if the Value is over range or under range. Ensure also that the Module status of 

the parent I/O module is configured correctly. 

• Ensure that the input point is not forced. 

When a point is forced, the Force property is True and the Forced button is highlighted. 

Ensure that the value of an I/O point is configured correctly if the value does not change. 

Verify also that point type, Channel number, scaling parameters, Units, and Threshold are set 

correctly. The point’s value does not change until the input delta exceeds the Threshold. 

• Verify that the input is wired correctly. 

• Test the I/O module hardware by applying the appropriate 

 

Output point not functioning correctly 

The parent I/O module is Configured and online. However, the output point is not functioning 

correctly. The module status is Unconfigured, the output point is offline, unreliable, forced or 

manually overridden, or configured incorrectly (for example, wrong point type, wrong 

channel, incorrect units, scaling, threshold, or bindings). Also, the output channel is 

miswired, or the I/O module is defective. 

When the output point is not functioning correctly, the problem is usually that the value is not 

being set, the physical output value does not change, or the value does not change with the 

requested value. 

The solutions are listed in order: the solution most likely to fix the problem is listed first. 

Work through each solution until the problem is resolved. 

• Ensure that the Comm status of the output point is set to Online and that the parent I/O 

module is Configured and Online. 

Check also that the I/O module is securely connected to the Automation Server and that the 

module ID is set to the position occupied by the I/O module. 

• Ensure that the point’s Reliability is set to Reliable. 

Verify also that the Module status property of the parent I/O module is configured correctly. 

• Ensure that the value changes with the Requested value. If the value does not change, verify 

that the point is not being forced or overridden. 
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When a point is manually overridden, the Override state property is True. 

When a point is forced, the Force property is True and the Forced button is highlighted. 

• Ensure that the value of an I/O point is configured correctly if the value does not change. 

Verify also that point type, Channel number, scaling parameters, Units, and Threshold are set 

correctly. The point’s value does not change until the input delta exceeds the Threshold. 

• Verify that the output is wired correctly. 

• Test the I/O module hardware by connecting a Digital Multimeter to the output if I/O 

module contains the manual override (-H) option. Manually override the different output 

values and verify that the Digital Multimeter displays the overridden values. 

Test the hardware by forcing the output to different values and verifying that the Digital 

Multimeter displays the forced values. 

 

Power Supply Overload 

 

The PS-24V status LED indicates a power overload by turning red, and the power supply 

shuts down. 

The solutions are listed in order: the solution most likely to fix the problem is listed first. 

Work through each solution until the problem is resolved. 

• Check if you have exceeded the total I/O Bus addressing power limits.  

• If the power limit has been exceeded, insert another power supply in a suitable position 

among the devices to reduce the power load on the original power supply. See the illustration 

below. 

• If you have NOT exceeded the power limits, inspect for failed I/O modules. A failed module 

could be drawing too much current and sending the power supply into overcurrent protection 

mode. 

• Remove/replace failed or less important I/O modules until power consumption has 

decreased to an acceptable level. 

 

Figure 4: I/O Bus addressing and Power Limits. 
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3. MODULE CONFIGURATION AND PROGRAMMING 

After installation of the SportE
2 

When Module, as already anticipated in D3.3 another 

fundamental and critical phase is the module configuration and programming. Once also the 

software is installed, the variables configuration is necessary. It is essential testing the whole 

control system by checking if each component is able to communicate with the others and 

with the possible local supervision system (e.g. resident BMS). This phase cannot be executed 

by simple electricians or installers; in fact, specific expertise and license are needed to access 

the Schneider Electric Automation Server, core of the SportE
2 

When Module. Therefore, only 

Schneider Electric accredited/authorized partners can configure and program the module by 

configuring those portions of the database that are required by the points list and sequence of 

operation agreed in the requirements analysis. In the next two sections, we reported how to 

configure and how to program the module, respectively. The sequences reported hereafter 

have been experienced and tested in the installation phase at the three pilots. 

6.1 Module configuration 

To deliver an efficient configuration of the When module it is fundamental to understand the 

organization of objects within an automation server and the different general types of objects 

within it. In fact, the database within the AS is a collection of objects. These objects send and 

receive data from other objects within the database. An application within an AS is made up 

of multiple objects working together to achieve a specific performance. 

Each object has a properties presentation that displays both static and dynamic information 

relating to the object. 

The most common types of objects in an automation server can generically fit in one of the 

following categories: 

 

I/O Modules and Physical points 

(sensors and end devices) 

The I/O Bus is a default object in the AS; under the I/O Bus 

there is an object that represents 

each I/O module installed on the I/O Bus. Under each I/O 

module there is an object that represents each physical 

input device and physical output device 

Folders 
Folders can be used to organize or group a collection of 

objects for better system management. 

Folders can reside under other folders for further 

organization of information. 

A folder becomes an entry in the “path” to an object that 

resides under the folder. 

Internal variables (internal points, 

numeric, etc.) and Program objects 

Program objects contain executable control logic 

If a program needs (or send) data from (to) another object 

an input connector or declaration can be defined. 

If a program needs data from the operator a writable 

public signal is defined. 

If data within the program is required to be viewable from 

workstation (example: graphics), the data must be declared 

to be “public”. 

Input data and output data are automatically public. 

Logical objects 
 

Time schedules 
- Discrete output 

- Integer output 

- Analog output 
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Alarm objects 
- Designed to monitor a defined input 

- Dispatch messages 

- Alarm state is a discrete output from the object 

Trend logs 
- Designed to monitor a define input 

- Store a log 

As a project in an AS is a collection of objects that work together, a flow diagram of how the 

objects relate to each other is the best way to visually plan your project. See the next scheme 

as example. 

 

Figure 5: Flow diagram example of project configuration in the When module. 

In the following, we have detailed the procedure to add Automation Servers to the system. 

1. In WorkStation, in the System Tree pane, select the Servers folder. 

2. On the File menu, point to New and then click Server. 

3. In the Name box, type a name for the server. 

4. In the Description box, type descriptive information about the server. 

5. Click Next. 

6. In the Address box, type the host name or IP address of the AS (Figure 6). 

If the Automation Server has been assigned a dynamic IP address, use the host name of the 

server instead of the IP address (which sooner or later will become obsolete). 

 

 

Figure 6: Configure IP/DNS Address and port. 

7. In the Protocol box, select a protocol for the server.  
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8. In the Port box, enter a port. 

9. Click Create. 

 

Using the Spreadsheet view, you can quickly create multiple I/O points, which you 

otherwise would create one at a time in the wizard. 

1. In WorkStation, in the System Tree pane, select the I/O module where you want to create 

the I/O points.  

2. On the Actions menu, click Edit in spreadsheet. 

3. In the Spreadsheet view, select the row with the channel that corresponds to the terminal 

connection on the I/O module where the input or output is wired. In this example, select 

the row for Input Channel number 1. 

4. In the Type column, select the type of I/O point. In this example, select Digital Input. 

 

 

Figure 7: Creation of multiple I/O points. 

5. Enter the rest of the properties, as you would do in the corresponding wizard. 

6. Create additional I/O points using Steps 3-5. 

7. On the File menu, click Save. 

 

You create analog values in the Automation Server or Enterprise Server for the following 

reasons: 

• A variable needs to be bound to multiple programs. 

• A calibrated analog input variable needs to be forced. 

 

You create analog values in the Automation Server or Enterprise Server for the following 

reasons: 

• A variable needs to be bound to multiple programs. 

• A calibrated analog input variable needs to be forced. 

 

To create a server analog value: 

1. In WorkStation, in the System Tree pane, select the server or folder where you want to add 

an analog value.  

2. On the File menu, point to New and then click Value. 

3. In the object type list, select Analog Value. 

4. In the Name box, type a name for the analog value.  

5. Click Create. 

 

http://www.sporte2.eu/


SportE
2
 D3.4  Page 23 of 65 

SPORTE
2
 – D3.4 When Module Complete 

www.sporte2.eu   

You create digital values in the Automation Server or Enterprise Server for the following 

reasons: 

• A variable needs to be bound to multiple programs. 

• A digital schedule or an alarm needs to send information to a program. 

 

To create a server digital value: 

1. In WorkStation, in the System Tree pane, select the server or folder where you want to add 

a digital value.  

2. On the File menu, point to New and then click Value. 

3. In the object type list, select Digital Value. 

4. In the Name box, type a name for the digital value.  

5. Click Create. 

You add weekly events to a schedule to determine when the event is to regularly occur. 

Weekly events always occur regularly unless overridden by an exception event. 

 

To add a weekly event: 

1. In WorkStation, in the System Tree pane, select the schedule you want to add the weekly 

event to.  

2.Click the Basic tab. 

3. On the Basic Schedule Editor toolbar, click the View weekly schedule (Figure 7) events 

button . 

4. In the grid, click the start time. Drag the cursor vertically to select the end time and then 

horizontally to select all days for which the event should be valid. 

 
Figure 8: View weekly schedule. 

5. On the File menu, click Save. 

You bind a digital value to a digital schedule so the variable status follows the scheduled 

times. 

 

To bind a digital value to a digital schedule: 

1. In WorkStation, in the System Tree pane, select the variable or value that contains the 

digital value.  

2. On the Actions menu, click Edit bindings. 

3. In the Browser pane, select the folder that contains the digital schedule.  
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Figure 9: Binding a digital value to a digital schedule. 

4. Select the digital schedule that you want to bind to the digital value.  

5. Drag the digital schedule to the Binding column for the digital value.  

6. On the File menu, click Save. 

6.2 Functional Block programming 

In a function block diagram (FBD), the function blocks process input signals and generate a 

single output signal. During the program execution, the output signal is forwarded to other 

blocks by using connections that represent the data flow from left to right. 

The first step when structuring is to make an outline structure by: 

• Identifying the main functions 

• Determine where to graphically locate these function groups in relation to each other. 

The grouping can be done in several ways. The most important thing is to make the FBD easy 

to understand. Function blocks that perform a function together should preferably be located 

together. 

The second step is to graphically locate the groups. Create a left-to-right logical sequence in 

the FBD. If there is a connection between two groups, place a group that delivers an output to 

the left of a group that receives an input. To standardize this, we recommend a logical order 

from left-to-right: START CONDITION – STOP CONDITION - GENERAL CONTROL - 

PID CONTROL SEQUENCES – ALARM HANDLING. 

Use the following rules of thumb when you locate blocks and groups: 

• Enter a framed comment containing the last edition date of the FBD in the upper left corner. 

History notes, describing the revision, can also be included. 

Update this information whenever you make a program revision.  

• Try to structure every page so that the physical input blocks are arranged in a column to the 

left, and the physical output blocks in a column to the right. 

• Adjust the function block diagram to the page break lines, to make a printout legible. 

• Make space between the groups so that it is possible to add connections and additional 

functions. 
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• Add new pages to the right when necessary, but try to use only one page in a vertical 

direction. 

• Locate connections like a bus with common left-to-right connections at the top of the 

diagram. Avoid mixing connections running in opposite directions. Put connections running 

in opposite directions in a separate bus at the bottom of the page. Mark the direction of these 

signals. 

• Reuse tested macros from the Macro Block Library or your own library as often as possible. 

• Structure the function block program so that all public signals that you want to display 

together belong to the same module (and have the same module name). 

When you program an Automation Server, the work can be divided into three fundamental 

phases: 

• Function phase: analyze the requirements 

• Design phase: program the function block program 

• Test phase: simulate the functionality of the function block program 

In the function phase, you read and analyze the functional specification. You add your 

analysis and form an overall solution. In this phase, you sometimes need to acquire more data 

regarding parts of the installation that affect the programming. An important part of this phase 

is to locate function block programs that are ready to use or that only require small changes, 

in the folder where you store your function block programs. 

During the Design phase, you start working in Function Block Editor. You identify points, 

name the points, and allocate them. You plan the structure of the function block program and 

finally build your function block program in Function Block Editor. 

During the test phase you can test a function block program in two ways: 

• In Simulation mode in Function Block Editor. 

• As a final system test where you download the complete function block program to an 

Automation Server and test it. 

 

Creating and importing functional block program 

You can create a Function Block program to import existing program code or to program new 

logic for the Automation Server using Function Block Editor.  

To create a function block program: 

1. In WorkStation, in the System Tree pane, select the server or folder where you want to 

create the function block program. 

2. On the File menu, point to New and then click Program 

3. In the object type list, select Function Block Program. 

4. In the Name box, type a name for the function block program 

5. Click Create. 

You can import function block program code to reuse all or parts of existing code. Function 

Block Editor supports import of .aut and .mta files created for Xenta 280/300/400 LonWorks 

devices in Menta Editor, as well as .aut file previously created in Function Block Editor. 

To import function block program code: 

1. In WorkStation, in the System Tree pane, select the function block program you want to 

import program code to 
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2. On the Actions menu, click Edit. 

3. In function block editor, on the File menu, click Import. 

4. Select the file you want to import 

5. Click Open 

6. On the File menu, click Save 

6.4 Script programming 

Script programs are text-based instructions that tell the server to take some kind of action to 

control a building. 

For example, you can tell the server to take the following actions: 

• Open the damper 

• Close the valve 

Each instruction is a complete text-command description. Program instructions are listed in 

the order in which the controller must perform them. 

You can store your Script programs like a common document and include them later in other 

projects for use in your control system. You can also write programs that perform very 

complex control system decisions, such as controlling lighting, boilers, and air handling units 

at multiple sites. 

Script programs are composed of the following components that allow you to develop your 

programs quickly and easily: 

• Program constants 

• Program operators 

• Program statements 

• Expressions 

• Variables 

For example, you can create program statements with everyday language, so you do not need 

to be a programmer to learn how to program with Script. 

The Script Editor is a text programming tool you use to create Script programs that control 

and monitor building automation systems. Script Editor opens when you create or edit a 

Script program in WorkStation. 

When you open a new program in the Script Editor, you begin by declaring local variables for 

the program input and output followed by names for those variables. The program starts with 

zero or more of these declarations followed by one or more lines specifying the operation(s) 

to perform. 

Script programs tell a server to perform numerous actions, such as increasing the heat, locking 

doors, and printing reports. The program instructions that command these actions are arranged 

and executed in a certain order, known as a program flow. 

Script has two types of program flows: FallThru and Looping. 

A FallThru program executes the program lines in the sequential order in which you list them: 

from the first line to the last line. Therefore, the program flows, or “falls thru” the entire 

sequence of instructions. 

A Looping program remains on one line until the program is instructed to go to another line. 
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Script has two types of program instructions: conditional and unconditional. A conditional 

instruction establishes criteria that have to be met before the instruction can be executed and 

the task performed by a server: 

e.g. IF Temp is 78 THEN Turn on Fan 

An unconditional instruction directs a specific action without establishing any criteria before 

the action can occur: 

e.g. Turn on Fan 

You can use “the” in a Script program instruction to make the statement easier to read. The 

following example show how “the” improves the readability of a statement: 

IF fan is on THEN turn on the pump. 

 

Creating and importing a script program 

You create a Script program to import existing program code or to program new logic for an 

Automation Server using Script Editor. 

To create a Script program: 

1. In WorkStation, in the System Tree pane, select the server or folder where you want to 

create the script program. 

2. On the File menu, point to New and then click Program 

3. In the object type list, select Script Program. 

4. In the Name box, type a name for the function block program 

5. Click Create. 

You import script program code to reuse all or parts of existing code. Script Editor supports 

import of .txt files created using the Plain English tool, as well as previously created script 

program files. 

To import script program code: 

1. In WorkStation, in the System Tree pane, select the script program you want to import 

program code to 

2. On the Actions menu, click Edit. 

3. In Script editor, click the Script button. 

4. Point to import and click Text or Plain English 

5. Select the file you want to import 

6. Click Open 

7. On the File menu, click Save 

6.5 Control rules implementation 

The control strategy implemented in the SportE
2
 When module consists of algorithms 

implemented into the AS in order to control the different plants present in a typical sport 

facility. In the next pages, we briefly describe some of the most common control strategies for 

lighting, heating, cooling and HVAC developed and pre-configured according to use cases 

defined. A set of basic control scenarios and relative control rules has been defined in 

agreement with SportE
2
 Why module.  

We report for sake of clearness some examples of basic control rules scheme for AHU (fan 

control, air humidity control and supply air temperature setpoint control, respectively) and for 

Swimming Pool Water Control, already described in D3.4 and in D4.4. 
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AHU Fan Control 

 

Figure 10: AHU fan control rule. 

In the above picture the control for the Supply Fan of an Air Handling Unit (AHU) with 

Variable Speed Drive (VSD) has been shown. In order to fully control this fan, human 

operator can monitor values from: 

- Outside air damper, 

- Three position Switch in the electrical panel, 

- Supply Air Velocity, 

- VSD drive signal, 

- VSD feedback signal, 

- VSD alarm and Status, 

- Differential air switch for the fan. 

If the three-position switch is in the Auto position and the time schedule is in time to operate 

then the system gives the enable signal for the unit to start. First the outside air damper has to 

open and as soon as operator receives the status of the damper that it is open in did, operator 

gives the command signal to fan to operate. Operator checks the supply air velocity and, by a 

PI control, operator gives to the VSD the appropriate signal to operate. 

In case that operator does not receive the correct signal from the VSD or the differential 

pressure switch, alarms occur in order to notify the system administrator. 
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AHU Humidity Control 

 

Figure 11: AHU humidity control rule. 

Humidity control for AHUs can be accomplished either with a solenoid water valve or with a 

steam generator. In both cases operators monitor the return/room air humidity in order to 

reach their set point and control the output accordingly. The supply air humidity sensor is 

used as a high limit safety. In case that operators have a solenoid valve, operators use On/Off 

control and in case that operators have a steam generator, the PI control is the most suitable. 

For de-humidification operator also uses a PI control and he drives accordingly the cold water 

valve of the AHU. In any case, the cold water valve receives the maximum signal from the 

de-humidification control and from the temperature control. 

Dehumidification can be used only if four pipe systems are controlled and cold - hot water is 

available at the same time. 

AHU Supply Temperature Control 

 

Figure 12: AHU supply temperature control rule. 
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For the supply temperature control, at least two temperature sensors are necessary: 

- Supply air temperature sensor, 

- Outside air temperature sensor. 

By this kind of control, the system calculates the valve opening based on a PI control between 

the supply air temperature and the desired set point. The outside air temperature gives 

operator the added value of the anti-frost control. If the unit is operating then only the cold 

water valve is opening (and the appropriate pump for anti-frost reason) otherwise, if the unit 

is not operating then both valves are opening for anti-frost reason. 

Swimming Pool Water Control 

Domestic hot water control for boilers has to do with three way mixing valve in the boilers 

output.  

 

Figure 13: Swimming pool water control rule. 

The domestic hot water controller has a load depending dead zone change over, to take care of 

low flow at hot water control. There is also a time control to set up a set point offset during 

night periods. The dead zone changeover takes place when the output signal goes below the 

set limit with a hysteresis of ± 1%. In order to have a system as steady as possible a PI 

controller for this plant is also used. The above example gives also the possibility to set back 

the temperature set-point during the night. 
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4. MODULE ACCEPTANCE TESTING 

This section is a workbook summary that describes a defined set of tests and assessments to 

check the correct module installation. System start-up procedure and testing steps are 

described in order to assure a successful deployment of the module in order to certify the 

module correct installation and configuration. 

7.1 System Start-up and Acceptance Testing 

Each point in the system has to be tested for both hardware and software functionality. In 

addition, each mechanical and electrical system under control (such as the chilled water, hot 

water and all air handling systems) of the SportE
2
 When module will be tested against the 

appropriate sequence of operation.  

Required elements of the start-up testing include: 

 Measurement of voltage sources, primary and secondary.  

 Verification of proper controller power wiring. 

 Verification of component inventory when compared to the submittals. 

 Verification of labeling on components and wiring. 

 Verification of connection integrity and quality (loose strands and tight connections). 

 Verification of bus topology, grounding of shields and installation of termination 

devices. 

 Verification of point checkout. 

 Each I/O device is landed per the submittals and functions per the sequence of control. 

 Analog sensors are properly scaled and a value is reported 

 Binary sensors have the correct normal position and the state is correctly reported. 

 Analog outputs have the correct normal position and move full stroke when so 

commanded. 

 Binary outputs have the correct normal state and respond appropriately to energize/de-

energize commands. 

 Documentation of analog sensor calibration (measured value, reported value and 

calculated offset). 

 Documentation of Loop tuning (sample rate, gain and integral time constant). 

Hereafter, the summary list of things to do in order to do the start-up of the SportE
2
 When 

module, once hardware and communications testing have been passed : 

1) Connect to an Automation Server Using the USB Device Port 

2) Set the Automation Server IP Address 

3) Upgrade Automation Server Firmware 

4) Preserve the Default Enterprise Server Database 

5) Logon to WorkStation 

6) Show the difference by logging in to first the ES and then the AS 

7) Login using Engineering workspace 

8) Rename the Server 

9) Create and Configure a Domain 

10) Create an Automation Server 
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11) Create an I/O Module 

12) Create folders 

13) Synchronize Time Settings on Multiple Automation Servers 

We described in details only steps from 9) to 13), which are the most critical ones. 

 

Creating and Configuring the Domain, AS and I/O Modules 

Tasks: 

- Create and Configure a Domain (in order to have access to all servers within the same 

domain) 

- Create an Automation Server 

- Create Multiple I/O Modules 

Steps: 

Domain: 

1. In WorkStation, on the Tools menu, click Control Panel 

2. In the Server box, select a server for which you want to create a domain: University X 

ES1 

3. Click Domain - Add 

4. Give the name: “University X Domain” - Next - Next – Create 

Automation Server: 

1. In WorkStation System Tree pane, select the Servers folder 

2. Right click - New - Server 

3. Give the name: “CPlant AS” 

4. Type description: “Automation Server controlling Central Plant and serving as the 

network interface for the field bus devices” - Next 

5. Address: host IP address of the AS (see printed A4 sheet) 

6. Protocol: Local Area Network (TCP) 

7. Port 4444 (standard TCP port) – Create 

IO-modules: 

1. In WorkStation, in the System Tree pane, select the I/O bus where you want to create the 

I/O modules. In this example, select ...University X ES1/Servers/CPlant AS/IO Bus 

2. Right click IO Bus - Edit in spreadsheet 

3. Select the first cell and scroll correct module Type: DI-16 

4. Name: Position03:DI16 and Module ID: 3 

5. Move down a couple of rows… 

6. Create three more: 

7. Type: DO-FA-12, Name: Position04:DOFA12, Module ID: 4 

8. Type: UI-8.AO-4, Name: Position05:UI8AO4, Module ID: 5 

9. Type: UI-8.AO-4, Name: Position06:UI8AO4, Module ID: 6 

10. Save 

 

Creating Physical IO Points 

Tasks: 

- Create points using this matrix 

Steps: 

- Right click the IO Bus and select “Edit in 

Spreadsheet”  

- Fill in the information in the matrix below  

- Use this symbol to change the unit _ 
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Creating the Folder Structure 

Tasks: 

- Create Folder structure 

You create folders to organize your Building Operation database.  

Here you create folders for University X ES1 and CPlant AS in the WorkStation System 

Tree, shown as example. 

Steps: 

1. In the System Tree pane, select the folder, 

server, or network, where you want to 

create the folder 

2. Select University X ES1 – right click - 

New - Folder 

3. Name: “Application” – Create 

4. Repeat the procedure to create the 

following folder structure in the ES:  

5. Create the following folder structure in the 

AS. This time with import function 

6. Right click CPlant AS – import 

7. Browse file “AS import for SBO 1.2 

Workbook.xml” – Open 

8. Import  

This will create the rest of the folders and objects. 

 

Synchronizing Time Settings on Multiple Automation Servers 

Tasks: 

- Define the primary and secondary network time server settings for connected 

shadow Automation Servers on the Enterprise Server. 

- Synchronize Time Settings on Multiple Automation Servers 

- Change the Time Zone of an Enterprise Server or Automation Server 

- Synchronize Time Zone Settings on Multiple Automation Servers 

Steps: 

Synchronize the CPlant AS time settings with the University X ES1 time settings. 

1. To synchronize time settings on multiple AS’s, on the Tools menu, click Control Panel or 

2. In the Server box, select the ES that you want to synchronize the AS time settings with: 

University X ES1 

3. Click Network time and time zones 

4. Enable “Network time synchronization on shadow Automation Servers” 

5. In the Primary time server box, type: fi.pool.ntp.org 

6. Select correct Time Zone - Save 

7. Search for the date and time object on all connected servers in your Building Operation 

system: In the Search box (upper right corner): Type “Date and Time” - Click the Search 

button 

8. In the Search view, select the servers with the time and date you want to synchronize with 

the ES time server settings - select CPlant AS 

9. Click the Show/Hide Property Grid button 

10. Click the Time tab 

11. In the Lead object box, write (or browse): /University X ES1/System/Time  
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7.2 Performance Verification Test 

A performance verification test should also be completed for the operator interaction with the 

system according to the following tasks: 

Figure 14: Performance verification test of the WHEN Module 

All application software will be verified and compared against the sequences of control 

operation that are defined according to the control scenarios adopted. Hereafter, some 

examples are listed for sake of clearness: 

 Boiler Control 

 Single/Multi Zone Air Handlers 

 Swimming Pool Water control 

 Swimming Pool Air control 

 Fan Powered VAV 

 Fan Coil Control 

 Heat Pump Control 

 Unit Ventilator Control 

Control loops will be exercised by inducing a set point shift of at least 10% and observing 

whether the system successfully returns the process variable to set point: it is worth to record 

all test results and attach to the Test Results Sheet. 

Test each alarm in the system and validate that the system generates the appropriate alarm 

message, that the message appears at all prescribed destinations (workstations or printers), 

and that any other related actions occur as defined (i.e. graphic panels are invoked, reports are 

generated, etc.): the Test Results Sheet have to be submitted to the owner. 

After this it is important to perform an operational test of each unique graphic display and 

report to verify that the item exists, that the appearance and content are correct, and that any 

special features work as intended. 

Finally it is needed to verify that all points are properly polled, that alarms have been 

configured, and that any associated graphics and reports have been completed. If the interface 

involves a file transfer over Ethernet, test any logic that controls the transmission of the file, 

and verify the content of the specified information. 

 

Performance verification test 
Graphics navigation 

Trend data collection and presentation 

Alarm handling, acknowledgement and routing 

Time schedule editing 

Application parameter adjustment 

Manual control 

Report execution 

Automatic backups 

Web Client access 
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Also the correct generation of Report is to be tested. The Contractor will configure a 

minimum of 4 reports for the owner. These reports shall, at a minimum, be able to provide: 

- Trend comparison data 

- Alarm status and prevalence information 

- Energy Consumption data 

- System user data 

Also a minimum documentation about the verification phase is to be provided to the owner.  

- As built software documentation will include the following: 

- Descriptive point lists 

- Application program listing 

- Application programs with comments. 

- Printouts of all reports. 

- Alarm list. 

- Printouts of all graphics  

- Commissioning and System Startup 
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5. GRAPHICS USER INTERFACES LIBRARY 

SportE
2
 When module offers an object-oriented, graphical operator interface, for handling the 

day-to-day operation of the installation and of the facility management. The graphics illustrate 

the installation and provide a simple explanation of it, in particular: 

 the graphics of a site have a hierarchical structure created by linking one graphic to 

another using link area. Within the hierarchy, the operator can move from a color 

graphic overview to plan drawings of buildings and floors, rooms, air handling units 

or other equipment. 

 the operator monitors, controls and supervises the facility by viewing the graphics; 

he/she can switch to graphics, change time settings, and change values and states. It is 

possible to link a graphic to an alarm; when the alarm is tripped, the operator can 

choose to display the linked graphic. Alarm states may be displayed in a graphic. The 

zooming and scrolling of graphics is supported. 

A graphic can contain links to documents, such as Microsoft Word or Adobe PDF, can be 

opened in WorkStation. The associated programs, in this case Microsoft Word or Adobe 

Reader, has to be installed on the computer running WorkStation. 

SportE
2
 When module also provides a graphics user interfaces library for human to machine 

interfaces, to help the installers about the creation and configuration of the graphics user 

interfaces related to sport facilities.  

In order to make easier and intuitive the visualization and consulting of the library it has been 

also realized an excel catalogue, reported in attached, and described later on. 

This is made from typical libraries based on the most common plants used within the sport 

facilities. The catalogue consists of the following libraries:  

1) Air Handling Units (AHU) 

a. 1 Heating coil - Recirculation damper 

b. 1 Heating coil - Recirculation damper 

c. 1 Heating coil - 1 Cooling coil - Recirculation damper 

d. 1 Pre-heating coil - 1 Cooling coil - 1 Post-heating coil - Recirculation damper 

e. 1 Pre-heating coil - 1 Cooling coil - 1 Post-heating coil - Recirculation damper 

- Humidifier 

f. 1 Pre-heating coil - 1 Cooling coil - 1 Post-heating coil - Recirculation damper 

- Humidifier 

g. 1 Heating coil 

h. 1 Heating coil - 1 Cooling coil  

i. 1 Pre-heating coil - 1 Cooling coil - 1 Post-heating coil - Humidifier 

j. 1 Pre-heating coil - 1 Cooling coil - 1 Post-heating coil - Humidifier 

2) Heating distribution 

a. 1 Hot circuit 

b. 1 Hot circuit - Regulation of the supply temperature 

c. 1 Hot circuit - Regulation of the supply temperature – External temperature 

compensation 

d. 1 Hot circuit - Pressure regulation 

e. 1 Hot circuit – Regulation of the supply temperature – Pressure regulation  
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f. 1 Hot circuit - Regulation of the supply temperature – External temperature 

compensation – Pressure regulation 

3) Heating generation 

a. 2 Boilers in cascade with primary circuit – Regulation of the supply 

temperature 

b. 1 Boiler and 1 CHP unit – Regulation of the supply temperature 

c. 2 Modulating boilers – Regulation of the supply temperature 

d. Heat exchanger – Regulation of the supply temperature 

4) Cooling distribution 

a. 1 Cold circuit 

b. 1 Cold circuit - Regulation of the supply temperature 

c. 1 Cold circuit - Regulation of the supply temperature – External temperature 

compensation 

d. 1 Cold circuit – Pressure regulation 

e. 1 Cold circuit – Regulation of the supply temperature - Pressure regulation 

f. 1 Cold circuit – Regulation of the supply temperature - External temperature 

compensation - Pressure regulation 

5) Cooling generation 

a. 2 Refrigeration Units in cascade with primary circuit – Regulation of the 

supply temperature  

b. Cooling exchanger – Regulation of the supply temperature  

Each catalogue page consists of a general description (at the top left), a graphic 

page (at the top right), the related main variables to be set and bound, lastly is reported the 

functional diagram program (at the bottom right) that allows to manage the plant functioning, 

of which are shown the main public signals, the inputs and outputs (at the bottom left). 

Within the graphic pages are shown the set points that can be modified by the workstation 

operator and an on/off time schedule for controlling the plant operation (see an AHU example 

in Figure 15). 

 

Figure 15: Primary air AHU with one heating coil and recirculation dampers. 
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The workstation operator can also see, on the graphical pages, the values of measured 

variables and the status of the plant components (such as flow alarms of funs, opening 

percentage of dampers, valve opening etc.) 

In the following some libraries as representative examples. 
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Primary air AHU with automatic selector functioning (according to time schedule), manual ON, manual OFF.  

Regulation of saturation temperature. The regulation acts in sequence at first on the recirculation/intake air 

dampers, in function of external and return air temperature and then on the pre-heating or cooling coil. 

Regulation of supply temperature. The regulation acts on the post-heating coil. 

Regulation of the return moisture. The regulation acts, in case of humidification, on the steam humidifier  and on 

the cooling coil in case of dehumidification. 

Regulation of the pressure on the supply duct. The regulation acts on the inverter of the supply air fan. 

Regulation of the pressure on the return duct. The regulation acts on the inverter of the return air fan. 

The antifreeze thermostat, when it intervenes, acts on the command of dampers, fans and on the heating coil signal, 

bringing it to 100%. 

1 Pre-heating coil – 1 Cooling coil – 1 Post-heating coil – Recirculation damper – Humidifer 

Inputs 

 

Public signals 

 

Outputs 

 

Bindable variables 

 

Part program 

 

Part program 
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Primary air AHU with automatic selector functioning (according to time schedule), manual ON, manual OFF. 

Regulation of CO2 detected on the return air duct that modules recirculation/intake air dampers to maintain the 

value below the set point.   

Regulation of chlorine detected on the return air duct that modules recirculation/intake air dampers to maintain the 

value below the set point.   

Regulation of temperature detected on the return air duct to limit the value of supply air temperature. The 

regulation acts in sequence at first on the recirculation/intake air dampers, in function of external air temperature, 

and then on the heating coil. 

1 Heating coil -  Recirculation damper 

Inputs 

 

Public signals 

 

Outputs 

 

Bindable variables 

 

Part program 
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Primary air AHU with automatic selector functioning (according to time schedule), manual ON, 

manual OFF. 

Regulation of saturation temperature. The regulation acts on the pre-heating or cooling coil. 

Regulation of supply temperature. The regulation acts on the post-heating coil. 

The antifreeze thermostat, when it intervenes, acts on the command of dampers, fans and on the 

heating coil signal, bringing it to 100%. 

1 Pre-heating coil – 1 cooling coil – 1 post-heating coil 

Inputs 

 
Public signals 

 

Outputs 

 
Bindable variables 

 

Part program 
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1 hot circuit with automatic selector functioning (according to time schedule), manual ON, manual 

OFF. 

The circuit consists of two pumps, one as reserve for the other, with daily rotation functioning. 

1 hot circuit 

Inputs 

 

Public signals 

 

Outputs 

 

Bindable variables 

 

Part program 
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1 hot circuit with automatic selector functioning (according to time schedule), manual ON, manual 

OFF. 

The circuit consists of two pumps, one as reserve for the other, with daily rotation functioning.  

Regulation of the temperature detected on the supply pipe; the regulation acts on the modulation of 

the 3 ways valve placed on the related return pipe of the circuit. 

1 hot circuit – Regulation of the supply temperature 

Inputs 

 

Public signals 

 

Outputs 

 

Part program 

 

Part program 

 

Bindable variables 
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1 hot circuit with automatic selector functioning (according to time schedule), manual ON, manual 

OFF. 

The circuit consists of two pumps, one as reserve for the other, with daily rotation functioning.  

Regulation of the temperature detected on the supply pipe balanced with the external temperature; 

the regulation acts on the modulation of the 3 ways valve placed on the related return pipe of the 

circuit. 

1 hot circuit – Regulation of the supply temperature – External temperature compensation 

Inputs 

 

Public signals 

 

Outputs 

 

Part program 

 

Bindable variables 

 

Part program 

 

http://www.sporte2.eu/


SportE
2
 D3.4  Page 45 of 65 

SPORTE
2
 – D3.4 When Module Complete 

www.sporte2.eu   

 

  

1 hot circuit with automatic selector functioning (according to time schedule), manual ON, manual 

OFF. 

The heat generation is made from the CHP unit and as support, when it is necdeed, also the boiler 

acts in order to regulate the supply temperature of the primary circuit. The primary circuit consists of 

the respective pumps, one as reserve for the other, with daily rotation functioning.  

Regulation of the pressure detected on the supply pipe; the regulation acts on the inverter modulation 

installed on the pump. 

1 Boiler and 1 CHP unit – Regulation of the supply temperature 

Inputs 

 

Public signals 

 

Outputs 

 

Bindable variables 

 

Part program 
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1 cold circuit with automatic selector functioning (according to time schedule), manual ON, manual 

OFF. 

The circuit consists of two pumps, one as reserve for the other, with daily rotation functioning. 

1 Cold circuit 

Inputs 

 

Public signals 

 

Outputs 

 

Part program 

 

Bindable variables 
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1 hot circuit with automatic selector functioning (according to time schedule), manual ON, manual 

OFF. 

The circuit consists of two pumps, one as reserve for the other, with daily rotation functioning.  

Regulation of the temperature detected on the supply pipe; the regulation acts on the modulation of 

the 3 ways valve placed on the related return pipe of the circuit. 

1 Cold circuit – Regulation of the supply temperature 

Inputs 

 

Public signals 

 

Outputs 

 

Part program 

 

Bindable variables 
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1 cold circuit with automatic selector functioning (according to time schedule), manual ON, manual 

OFF. 

The circuit consists of two pumps, one as reserve for the other, with daily rotation functioning.  

Regulation of the temperature detected on the supply pipe balanced with the external temperature; 

the regulation acts on the modulation of the 3 ways valve placed on the related return pipe of the 

circuit. 

1 Cold circuit – Regulation of the supply temperature – External temperature 

compensation 

Inputs 

 

Public signals 

 

Outputs 

 

Part program 

 

Bindable variables 
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1 cold circuit with automatic selector functioning (according to time schedule), manual ON, manual 

OFF. 

The cold water generation is made from 2 refrigeration units in cascade that regulate the supply 

temperature of the primary circuit. The primary circuit consists of the respective pumps, one as 

reserve for the other, with daily rotation functioning.  

Regulation of the pressure detected on the supply pipe; the regulation acts on the inverter modulation 

installed on the pump. 

2 Refrigeration Units in cascade with primary circuit – Regulation of the supply 

temperature compensation 

Inputs 

 

Public signals 

 

Outputs 

 

Part program 

 

Bindable variables 
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6. TRAINING TO BUILDING MANAGERS 

After installation, configuration, programming and start up verification test of the SportE
2
 

When module, in this Chapter, we briefly show how the management functionalities of the 

module are explained to the building managers and/or owners in order to train them to a 

complete awareness of the supervision and management capabilities of the module with 

respect to sport facilities plants/systems and spaces monitoring and control. 

9.1 Module overview 

The SportE
2
 When module installer shall provide both on-site and classroom training to the 

owner’s representative and maintenance personnel. On-site training shall consist of a 

minimum of 40 hours of hands-on instruction geared at the operation and maintenance of the 

systems. The curriculum shall include: 

 System Overview 

 System Software and Operation 

 System access 

 Software features overview 

 Changing setpoints and other attributes 

 Scheduling 

 Editing programmed variables 

 Displaying color graphics 

 Running reports 

 Workstation maintenance 

 Viewing application programming 

 Operational sequences including start-up, shutdown, adjusting and balancing. 

 Equipment maintenance. 
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Figure 16: Training program for the WHEN Module. 

Factory, classroom training will include a minimum of (2) training reservation for a 3 day 

course with material covering workstation operation tuition free. The option for 2-3 weeks of 

system engineering and controller programming shall be possible if necessary and desired. 

9.2 Managing and supervision 

Workstation overview 

WorkStation is the main interface to SportE2 When Module. You use WorkStation to perform 

all work on a daily basis. In WorkStation you can customize your workspace to some extent.  

You can, for example, decide where workspace components, such as, Alarms are displayed. 

You are notified by alarms when some important event occurs. For example, if the 

temperature is too low or too high in a building, if a window is open, or if something is 

broken, such as a fan. The system administrator sets up the alarms and decides to whom the 

alarm is sent. 

All system events, as well as information and circumstances, are recorded in the Event log. 

These event records can be viewed in the Events pane or in an Event View. 

You log on to WorkStation with your current Windows credentials, as another Windows user, 

or as a Building Operation user. Your system administrator decides which type of user you 

log on as. To log on to WorkStation using a Building Operation account, you need to know 

the following account information: 

• User name 

• Password 

• Domain 

• Server 

System Overview 

System Software 

System access 

Software features overview 

Changing setpoints and other attributes 

Scheduling 

Editing programmed variables 

Displaying color graphics 

Running reports 

Workstation maintenance 

Viewing application programming 

Operational sequences 

Equipment maintenance 
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To log on to WorkStation using a Windows account, you need to know the server. The 

account information for both the Building Operation account and the Windows account is 

provided by the system administrator (ensure that you have a working and available 

WorkStation license; a working license is required to log on to WorkStation). 

The workspace in WorkStation and WebStation is the area where you perform all tasks at 

your site, such as acknowledging alarms and viewing trend logs. The workspace is made up 

of different components, such as panes, lists, and views. These components can be configured 

in a number of different ways. You can hide or display components and create and save your 

own workspace. You can also reset the workspace layout to the default layout for the user 

group your user account belongs to. WebStation uses cookies to remember your workspace 

when you log off. When you log on again, you get the workspace you used when you logged 

off. If you clear your web browser, you will regain the default workspace. 

Some objects have specific viewers in WorkStation and WebStation: 

 

- Alarms 

- Documents 

- Graphics 
- Events 

- Trend Charts 

- Trend Log Lists 

- Schedules 

- Calendars 

A pane is a separate area in the workspace. You use panes to carry out commands, navigate 

the system or display information. Panes can be moved, hidden, closed, and repositioned. A 

pane is integrated into the WorkStations workspace and can be moved around inside the 

workspace. You can move a docked pane by dragging the pane in the Work area. 

You can change and force values using a graphic or the Properties pane. Using the Watch 

pane in WorkStation, you can dynamically monitor a value. 

When you force a value, all input from the system is overridden. For example, a schedule is 

set to start a fan at 09:00 but you want it to start at 08:00. In this case, you can force the fan to 

start already at 08:00. 

A forced value can be released at any time. When you release a forced value, the value returns 

to its normal status. A forced value is indicated by an orange button named Forced in 

WorkStation. In WebStation, a forced value is indicated by a pointing hand. You can view the 

unforced value, which is the real value from the system, at any time. 

Alarms 

You are notified by alarms when some important event occurs. For example, if the 

temperature is too low or too high in a building, if a window is open, or if something is 

broken, such as a fan. The system administrator sets up the alarms and decides to whom the 

alarm is sent. 

When an alarm is triggered, this is displayed in a list together with information about the 

alarm and its current status. In the list, you can manage the alarms, for example, acknowledge, 

accept, and comment alarms. In addition, you can sort, hide, and disable alarms in the list. 

You can also open a detail view to get information on all properties of an alarm. 

When you acknowledge an alarm, you let other users know that you have seen the alarm. 

Acknowledging an alarm does not necessary mean that you are responsible for solving the 

cause of the alarm. 
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A triggered alarm can be manually or automatically assigned to a specific user or user group 

that seems to be most suited to correct the problem. 

An assigned alarm indicates for other users that someone is working with the problem that 

caused the alarm. The name of the user that is assigned to the alarm together with the 

assignment status is displayed in the Alarms pane in WorkStation or WebStation, and in the 

Events pane in WorkStation. 

If an alarm is assigned to you, you can either accept the assignment request or reject it. 

Rejecting the assignment request means setting the assignment alarm back to unassigned. If 

you accept the assignment but realize that you are not the right person to correct the problem, 

you can release the assignment or assign the alarm to another user. If nobody has assigned an 

alarm, you can do a self-assign. When self-assigning, the status of the assignment is changed 

from unassigned to accepted with your name. 

You can assign an alarm to a user independent of the current assignment state. 

 

Figure 17: Alarm assignment process for the WHEN Module. 

Alarms can have attachments. The attachment can be a link pointing to an object in the 

system, for example, a report, a trend chart, or a schedule. The attachment can also be a 

graphic, a Microsoft Word file, a PDF file, a video recording, a voice message, or a pop-up 

window that contains information regarding the alarm. 

In WebStation, you can open attachments that refer to objects in the system. In WorkStation, 

you can also open other types of attachments, provided that the program or editor associated 

with the attachment is locally installed on your computer. For example, if the attachment is a 

PDF file, you can open the file if Adobe Reader or a similar program is installed on your 

computer. 

To quickly get all the details of a specific alarm or event in WorkStation, or an alarm in 

WebStation, you can use a Detail view. The Detail view always displays all properties that 

can be added and displayed in the Alarms pane, Events pane, or Alarm view. 
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In WorkStation, you use the Detail view to display all the properties and their values for the 

selected alarm or event. Use the Quick filter to limit the number of properties listed in the 

view. 

9.3 Equipment maintenance 

The When Module provides backup and restore programs that use multi-tasking capabilities 

of the BMS that run in conjunction with any other application on the system and it doesn’t 

inhibit another use of the terminal. The database backup shall be done dynamically while the 

applications of alarm monitoring and control remain active. The number of active events to be 

stored must be defined by the user. If the event log becomes full before an archive backup is 

done, the system shall begin to overwrite the oldest events to make space for the most recent 

events (FIFO). 

If something unexpected happens to a When Module, for example, it does not start or 

software files are missing, you can try to solve the problem by repairing the installation. 

To repair the installation you must have access to the installation package that was used to 

install the Module. When starting the installation the wizard asks if you want to reinstall or 

repair the current installation. When repairing the When Module, the current product related 

database, files created by the user, and user settings are kept intact. System files are replaced 

with the files from the installation package. 

Replace Enterprise Server or WebReports Computer Workflow 

Use this workflow to change the operating system on the computer where the Enterprise 

Server is installed. You can also use this workflow to migrate WebReports or the Enterprise 

Server to another computer. 

Prior to changing the operating system where the Enterprise Server is installed or migrating 

the Enterprise Server to another computer, complete the tasks listed in the following 

flowchart. 

 

Figure 18: Replace Enterprise Server or WebReports Computer Workflow. 
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Before changing the operating system or replacing the computer, it is strongly recommended 

that you archive the historical data and back up the servers to preserve the current data and 

configurations. 

Use Software Administrator (or the Services tool) to stop the Enterprise Server Windows 

service. If you are upgrading the License Server, stop the License Server Windows service. 

Automation Server Replacement Using Restore 

Backup and Restore assures that When Module server data can be restored after a hardware 

failure or data loss. As a precaution, you back up your Automation Servers regularly so that 

you can use the most current backup to restore the server data to a replacement server. You 

also configure the new server to match the name and the network settings of the replaced 

server so the system can identify this server when online. 

When you back up a server specifying either Configuration only or All data, the When 

Module includes all the configuration values that are specified for the server’s objects. If you 

restore the server, the module restores these configuration values, which can overwrite any 

changes made since the last backup. 

The When Module does not include most variable settings in a backup, consequently it cannot 

restore these variable settings. However, the system does back up the cold-start retained 

variables. 

Restore from an Automation Server 

When you restore an Automation Server locally, the system retrieves the current master 

backup set for that server. However, you cannot select a particular backup set because the 

Automation Server stores only one backup set at a time. 

Restore from an Enterprise Server 

Unlike an Automation Server, an Enterprise Server can store multiple local and nonlocal 

backup sets. When you restore an Enterprise Server, you can select a local backup set from a 

list of files to restore the server. In multiple server sites, the Enterprise Server manages all the 

Automation Servers in its group. In this configuration, the non-local backup sets are stored in 

separate folders for each Automation Server. 

When you restore an Automation Server from an Enterprise Server, you can select a particular 

backup set from a list of files that are stored for that Automation Server. This restore method 

provides greater flexibility. 

If your network uses DNS server names or static IP addresses, you need to apply a valid DNS 

host name or IP address to a replacement server. Specifically, you use the host name or static 

IP address to locate the new server on the network. To reconfigure the default TCP/IP settings 

on the new server to match those of the replaced server, you use the Automation Server Web 

Configuration utility.  

If your network uses DHCP, a new server can automatically acquire TCP/IP configuration 

information from a DHCP server. When acquired, you use the DNS server name rather than 

the IP address to locate the new server on the network. By default, DHCP is turned off on 

Automation Servers. To enable this and other network settings on the new server, you use the 

Device Administrator. 

In a single Automation Server site, you log onto the server in WorkStation to manage Backup 

and Restore operations. In this scenario, you need to have a valid backup set to restore the 

server in case the hardware fails or data is lost.  
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An Automation Server only stores one backup set at a time. Therefore, you should create a 

backup set when the server is functioning properly and then store this backup set in different 

location. You save and store a backup set on your WorkStation PC or network drive. You 

then can import this backup set to the Automation Server. 

In a multi-server site, you can log onto an Enterprise Server in WorkStation to manage 

backup and restore operations for all the Automation Servers in the group. Unlike an 

Automation Server, which only stores one backup set at a time, the Enterprise Server can 

store multiple backup sets for each Automation Server. From the AS Archives folder, you can 

select a stored backup set that was created when the server was functioning properly. 

To store a backup set in another location, you save a selected backup set to a folder on your 

WorkStation PC or network drive. You then log onto the new Automation Server to import 

this backup set to the local directory. If you do not log off from the Enterprise Server, the 

system uses the most current backup set stored on the Enterprise Server hard drive instead of 

the newly imported file on the Automation Server. Therefore, be sure to log onto the 

Automation Server before restoring the server in WorkStation. 

Replacing an Automation Server is a five-step process: saving a backup set, adding the new 

server to the network, configuring the new server, importing the backup set, and restoring the 

server. 

 

The Restore process automatically renames the When Module server and specifies the objects 

and properties that the server uses to reestablish links and go online. 

9.4 Running reports 

The When Module shall provide, at least, the following standard reports:  
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 Log user activity 

 History alarms report 

 Status of alarm point report 

 Status of controller report 

 Status of workstation report 

 Points in each controller 

 Points in alarm 

 Disabled points  

 Points manually operated (override) 

 Program listing by the controller with 

status. 

 Network status of each controller 

Each report must have printed the date and time in which the report has been performed. 

Reports must be displayed on the screen when the report is executed and the data have been 

compiled. 

The software contains a generator of customized reports (Report Server), with word 

processing tools to create custom reports. These customized reports shall be able to be 

configured for automatic execution or generated on request. 

Reports can be of any length and contain attributes of the points from any controller on the 

network. The report generator shall have access to the programming language of the user, in 

order to perform mathematical calculations within the body of the report, check the output of 

the report view , or asking the user for additional information needed for the report. 

It is possible to run other executable programs each time that a report is started. The software 

shall allow simple configuration of relations row/column (spreadsheet) on any class of objects 

in the system. These reports shall to be user configurable and it shall be able to extract real 

data (from the controller) and/or from the database.  

The user must be able to set up any report using any font or text color and background color. 

In addition, the report shall to be configured to filter data, sort data, and highlight data that 

meets the criteria defined by the user. 

Use the Schedule Reports page to create a schedule that runs a dashboard report for the 

frequency, date, and time you specify. 

 

 

Figure 19: Schedule Reports Page. 

Select existing schedule: Select a schedule whose properties you want to modify. Or, select 

New Schedule. 

Report schedule name: Type a name for the schedule if you selected. 

http://www.sporte2.eu/


SportE
2
 D3.4  Page 58 of 65 

SPORTE
2
 – D3.4 When Module Complete 

www.sporte2.eu   

New Schedule: Displays the name of the schedule if you selected an existing schedule. 

Schedule description: Type a description for the report schedule. The description displays in 

the Windows Task Scheduler after you save the schedule. 

Select a dashboard report: Select the dashboard report that you want to schedule. 

Frequency: Select how often you want the scheduled report to run. 

Start schedule: Enter the date and time to run the schedule if you selected Once for 

Frequency. Enter the date and time to activate the schedule if you selected another option for 

Frequency. 

Every x day(s): Type a number to run the schedule every day, every two days, or any number 

you specify. 

Days: Select to run the schedule on the days of the week you specify. 

Every x week(s): Type a number to run the schedule every week, every two weeks, or any 

number you specify. 

First: Select to run the schedule on the first day of the month. 

Last: Select to run the schedule on the last day of the month. 

Report output format: Select the format for the report output. 

Report output destination: Type the file path of the report output destination. The default 

path is on the local hard drive of the Reports Server. 

Overwrite prior report output: Select to keep only the most current scheduled report output. 

Disable schedule: Clear the box to run the schedule. Select the box to temporarily disable the 

schedule. 

Save as: Click to open the Schedule Name box where you can enter a name for a new 

schedule.  

Save: Click to save the criteria you entered. 

Delete: Click to delete the schedule that you selected. 

Clear: Click to remove the criteria you entered. 

 

Use the Main page to select a report from the Reports Tree and to select WebReports menu 

options. The main page is available when you log on to WebReports using a Web browser. 
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View Reports: page where you view and optionally, customize a report. 

Images: page user that can be used in your reports. You also use the page to delete images 

from the Images Library. 

Report Packs: page where you upload and Reports download report packs. 

Schedule Reports: page where you create schedules to run dashboard reports on specified 

days and times. 

Manage Reports: page where you rename and delete custom reports. 

 

Trend logs 

You use trend logs to record values, such as a sensor. A trend log can also log consumptions, 

such as energy consumption or water consumption. 

The function of a trend log is to log the variable that it is connected to and store the records. 

To be able to store larger amount of records, you connect an extended trend log. The records 

of the trend log and the extended trend log can be presented numerically in a trend log list or 

graphically in a trend chart. The records can also be processed by a calculation method before 

they are presented. 
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Figure 20: trend logs process. 

You use a trend log to collect data and then store the records. A record contains a log value or 

an event as well as its time stamp and an optional comment. A trend log can log an analog 

variable, a digital variable, or an integer variable. 

For performance reasons and to make the trend log less sensitive to if a server goes off line, it 

is recommended that you place trend logs as closely to the logged variable as possible. 

Preferably on the server where the logged variable is located. For example, if a sensor is 

connected to an Automation Server, the trend log that records the temperature should be 

placed on that Automation Server. 

You can use extended trend logs to structure the log data and to store it where there is greater 

storage capacity. 

When you create a trend log, the wizard helps you create and set up an extended trend log, a 

trend log list, and a trend chart as well as the chosen trend log type. 

 

Trend Log Types 

Interval Trend Logs: The interval trend log collects data at a specific time interval. Each 

logged value is stored as a record in the trend log. Use this trend log when the logging interval 

is less than 1 hour. You create interval trend logs using WorkStation or WebStation. In 

WorkStation, you configure the properties of the interval trend log to meet the specific needs 

of your site.  
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Meter Trend Logs: The meter trend log is a variable triggered trend log with extra 

functionality to seamlessly handle consumption calculations independent of meter rollover or 

meter exchange. 

Change of Value Trend Logs: The change of value trend log records the variable each time 

the difference between the current value and the last log value exceeds the delta. Use the 

change of value trend log to, for example, recording a variable that has an unequal oscillation. 

Variable Triggered Trend Logs: The variable triggered trend log records the variable 

according to the changes of an associated trigger variable. Use this type of trend log when the 

log interval is scheduled to log monthly or yearly, or when another device is used to trigger 

the log. 

Manual Trend Logs: The manual trend log records data that you manually enter. The manual 

trend log does not log a variable. Use this type of trend log when values from offline devices 

have to be manually registered to the trend log. For example, if you want to create a trend log 

that monitors an electricity meter that cannot be connected to the When Module. 

Implicit Trend Logs: The implicit log is a change of value trend log which monitors the IO 

variable and records a new value if the variable exceeds the delta. Each log value is stored as 

a record in the trend log. The delta is automatically defined by the When Module depending 

on the measured unit of the device that is connected to the IO port. 

 

All trend logs store records by using the circular storing principle; you can also connect trends 

logs to external trend logs with larger storing capacity. For some trend logs you can set up 

conditions that have to be fulfilled before the trend log starts recording. 

A trend chart displays the records of a trend log or an extended trend log as a series. 

A trend chart series that presents a trend log is automatically updated with the latest records, 

provided that Live update is activated. A trend chart series that presents records from a field 

controller trend log needs to be refreshed manually. 

There is no upper limitation of how many trend logs a trend chart can present. However, the 

performance decreases as the number of displayed trend logs increase. The records of the 

trend log can be processed by a calculation method before they are presented in the trend 

chart. 

The trend log list numerically displays the records of a trend log or an extended trend log. The 

records of the trend log can be processed by a calculation method before they are presented in 

the trend log list. 

The trend log list can only display one trend log at a time and must be manually refreshed to 

display recently recorded values. 

You use the mass create feature to create multiple identical alarms or trend logs for different 

objects, instead of creating the alarms or trend logs one by one. From trend logs, you can 

mass create extended trend logs. 
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Figure 21: creation of multiple identical alarms or trend logs for different objects. 

The main principle in When Module is that what you can do from one object or property, you 

can mass create from a number of selected objects or properties on a one to one basis. For 

example, you have seven objects that you want to monitor with seven interval trend logs. By 

selecting the objects and starting the ordinary New Object wizard, you configure a generic 

interval trend log template. When finishing the wizard automatically creates seven identical 

interval trend logs that monitor individual objects. 
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10. CONCLUSIONS 

SportE
2
 When module consists of a smart integration of hardware components, 

communication protocols, software and applications, data models, machine-to-machine, and 

machine to human interfaces. According to the requirement analysis, the SportE
2
 When 

module has been designed and developed with the integrated solution in mind, interfacing 

with other SportE
2
 modules (HOW, WHY, and WHERE). 

The technical concept, the layout and the description of the SportE
2
 When Module with its 

control architecture and main functionalities were first reported in deliverable D3.2. The main 

components and the connecting interfaces were described in detail, as well as module’s macro 

functionalities, its layout and the technical features with particular emphasis to the inter-

communications aspects. A first prototype of SportE
2
 When module was successfully 

installed, configured and integrated to Kubik (Bilbao, Spain) test facility.  

In deliverable D3.3, thanks to the experience acquired during Kubik installation and testing, a 

detailed description of the SportE
2
 When module as a product, ready for deployment at the 

three project’s pilots, was done. We focused there on the methodology and functional 

architecture to plan and install it, taking into consideration pilot requirements and 

technological constrains, as well as pilot owner/manager requests. A SportE
2
 When module 

delivery plan for each pilot facility was defined and detailed, providing three valid usage 

examples of product delivery. It was reported the complete list of control devices deployed in 

each sport facility, according to the architecture designed thanks to the technical audits, and 

the executive control installation plan. 

The experience acquired during the deployment at the three project’s pilots (AS. FIDIA in 

Rome (Italy), EMTE in Bilbao (Spain) and St. Maria de Lamas in Portugal) has allowed us to 

refine and validate the installation executive plan and procedure of the SportE
2
 When module. 

A detailed and codified installation and commissioning procedure – from wiring to software 

installation - for installers (either facility management company or electricians) are the main 

outcomes of this last period of WP3: the instructions to install an Automation Server, to set 

multiple I/O points, the analog values, the scheduling of events etc.  

Afterwards, module Configuration and Programming sequences have been clarified and 

defined: it is explained how to create and import functional blocks and script programs in 

order to program the AS with some typical control rules for sport facilities, defined and 

assessed along the project in the three pilots. Specific expertise and license are needed for 

these last phases; therefore, only Schneider Electric accredited/authorized partners can 

configure and program the module. 

Module Acceptance Testing comprehensive of all the validation tests (at communication, 

device, system level) have been defined and described as well as the system start-up and 

successive performance verification test for SportE
2
 When module complete delivery to the 

customers. We provided a sort of workbook that describes a defined set of tests to check the 

correct module deployment. 

SportE
2
 When module also provides a graphics user interfaces (GUI) library for machine to 

machine and human to machine interfaces, to help the installers about the creation and 

configuration of the graphics user interfaces related to sport facilities. In order to make easier 

and intuitive the visualization and consulting of the library it has been also realized a 

catalogue. 
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After installation, configuration, programming and start up verification test of the SportE
2
 

When module, we summarized the training programs, a general workstation overview, alarms, 

trend logs management, how to generate reports and manage facilities systems and plants. All 

this training material shows the management functionalities of the module to building 

managers and/or owners in order to train them to a complete awareness of the supervision and 

management capabilities of the module with respect to sport facilities plants/systems and 

spaces monitoring and control. 

In conclusion, we can assess that the SportE
2
 When module, after installation and validation 

at the three project’s pilots, has been complete and it is ready for the sport facilities energy 

retrofit market placement. 
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